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......................................................................................... 
G R A P H I C   D E S I G N 

Introduction 
 
It is known as pictorial format of illustration, which may consists of several colors, 
according to this concepts the graphic is combination of Color, which will represent in a 
pictorial format.  It is the logical creation of your own idea, which can be representing 
using the pictorial format, and in overall, the graphic design is known as combination of 
logical expression represents in pictorial format.  
 
Color Mode 
There are several color modes they are needed to the design you are going to develop. 
For example if you need more color combination then you need to choose CMYK or 
RGB, In addition, if you need only a black and white color then you can choose Gray 
Scale Color Mode. RGB MODE, CMYK MODE, GRAY SCALE, BITMAP MODE 
 
Save/ save as image format 

A d o b e   I l l u s t r a t o r   1 0 

JPEG, GIF, PNG, TIFF, PDF 
 

 
Getting started: 
    Adobe illustrator Pp6f freehand drawing software xf]. o;nfO{  ADOBE corporation, 
sDklgn]  software package  sf] ?kdf ahf/ NofPsf] xf]. o; af6 xfldnfO{ cfaZos cg';f/ create 
logos, free hand drawing, banner making, text edition, web template design, book 
cover design / c? design agfpg ;S5f}F.. 
How do I open Adobe illustrator? 
Steps: 

1. Select start button 
2. Click on all Program. 

  or 
3. Click at run and on the box type “Illustrator” and hit ok 
After a while the adobe illustrator window will displays  
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Working with art area 
 
Steps: 
 

1. Click at file menu 
2. Select New then a box displays 

 
3. Change the following settings For example.... 
4. Name = your art name, art board set up size = select required size here e.g. 

800* 600, unit = inch or any, width = 4 or your requirement, height = 3 or 
your requirement, orientation = portrait or land scape, color setup = any as 
you need e.g. CMYK and finally 

5. Click ok to get art area. 

 
 
Creating Multiple Pages 

1. Open Illustrator 
2. Go to File menu or choose new, and define reuirqed height and width eg. 

Width=3” height=2”, unit=inches and click Ok 
3. After that click at File menu > Choose document set up and tick on (√) Till 

full page and enter the following units, 
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for example  
 10 pages => width=3X10=30 Height=2X10; i.e. 20 and click Ok. 
4. Now you have 10 pages of 2X3 inches visiting card layout 
5. Create a complete design on Page 1 and select press Ctrl+G (Group) and 

holding on Alt key and Selection Tool allow you to create a duplicate copy 
of some contest 

 

 
 
Black Arrowhead (Selection tool) 

 
black arrowhead tool nfO{  selection tool klg elgG5. of]   tool  sf] ;xof]u af6 object  nfO{ 
move ul/ csf]{ location n}hfg;lsG5.  
Example: 
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Steps: 
1. Draw a rectangular object 

 
 

2. Select Selection tool, click on object and move it to required location and 
check the effect 

 

 
This tool allows you to increase or decrease the selected object but it is not good 
way to use. 
 
White Arrowhead (Direct selection tool) 

 
 
The white arrowhead tool is known as direct selection tool and this tool allow you 
to change and object shape dragging from its anchor point. 
 
Anchor point 

 it is a small tiny box, which occurs at the corner or middle portion of the 
object. 
Steps: 

1. Crate a rectangular object 
2. Choose direct selection tool and click exactly on the path (line) then a white 

tiny box occurs, which is known as anchor point 
3. Click exactly on the anchor point and drag to require position to change its 

shape 
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Magic Wand tool: 
  

 
This tool allows you to active the current deselect object 
Steps: 

1. Firstly add some object 
2. Then deselect it and then choose magic wand tool and click exactly on the 

object to make it active 
 
Direct Select Lasso tool  
 

 
This tool allows you to active the deselect anchor point so that you can change an 
object shape 
Steps: 

1. Add some object on art area 
2. Then choose direct select lasso tool and click and drag across the object and 

check the effect 
 

Pen tool: 

 
 
 This tool allows you to draw a straight line and, curve line  
 
Straight line:  
Steps: 

1. Choose Pen tool  
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2. Hold on Shift key and click once on the art area 
3. Then click to another point holding on shift key and check the effect 

 
Curve line: 
Steps: 

1. Choose Pen tool 
2. And Click and Drag the pen tool, now you can see 3 anchor points 
3. Just select the anchor point (not the middle one) then click and drag 

up/down to make a curve line 
The central part of the anchor point is heart of the line that’s why you are not 
allowed to click over there if you try to click and drag from there then there will 
be no line visible. 
 
Add Anchor Point:  
(The pen tool with + sign), this tool allows you to add anchor point on the selected 
object 
Steps: 

1. Draw any object 
2. Choose add anchor point and click exactly on the path of object, to add 

more anchor (but do not click over the previous anchor point) 
3. Then you can see a new anchor point is added over there. 
4. This is to change and object shape by adding require anchor points 

 
Subtract Anchor Point  
(The pen tool with – sign), this tool allow you to remove the anchor point which is 
previously visible. 
Steps: 
 

1. Draw any object 
2. Then choose Subtract Anchor Point 
3. And click exactly over the previous anchor point and check the effect 

 
Convert Anchor Point tool: 
 This tool directly allows you to change an object shape as your requirements 
Steps: 

1. Draw a rectangular object 
2. Choose convert anchor point tool and click and drag from the anchor point 

and check the effect 
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Type tool 

Normal type tool: default type tool 
 
Steps: 
 

1. Choose “T” tool and click once on art area and type your text 
2. Or if you need to type your text with in a certain boundaries then first click 

and drag to define a fixed area and type your text after that 
 
Area Type tool: 
 Allow you to type the text with in a given area 
Steps: 

1. Create a rectangular object 
2. Choose area type tool and click once on the path of the object and type your 

text 
 
Path Type tool:  
Allow you to type the text with in a given path. 
Steps: 

1. Create a path using pen tool and draw a curve path 
2. Then choose Path type tool and click once on path and type your text and 

check the effect 
 
Vertical type tool:  
Allow you to type vertical text in the art area 
Steps: 
 

1. Choose vertical type tool and 
2. Then type your text 

 
Vertical Area Type tool:  
This tool is very similar with area type tool but it types vertically  
Steps: 

1. Create a rectangular object 
2. Choose vertical area type tool and click exactly on the path of the object 

and type your text And check the effect 
 
Vertical path type tool:  
Allow you to type vertical path text within a given path 
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Steps: 
1. Create a path, using pen tool likely curve 
2. Then choose vertical path type tool and click exactly on the path and type 

your text and check the effect 
 
 
Type Effect: 
Reverse path type effect. 
Steps: 
 

1. Choose Circle tool and draw a circle on art area 
2. Then choose Path type tool and type “Kathmandu Nepal” 
3. When finished choose Selection tool now you can see a thin mouse cursor 

sign before the text start area 
4. Just double click on the cursor inside of the circle object  
5. Now you will have the following effect 

 

 
 
Creating outline color text 
Steps; 

1. Choose type tool and select font size = 72 and font style = impact 
2. Now type “STUDENT” 
3. Then on the color box choose fill color= None and Stroke color= any color  

Now you will have outline color text 
 
Creating Color full text 
Steps: 

1. Type GRAPHIC 
2. Then select direct selection tool and right click on text and choose “create 

outlines” 
3. Then on the tool box inside the scissor tool choose knife tool and divide the 

text as you nee 
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4. Now with the help of direct selection tool click once on the art area and 
then click on the divided portion and from the color box choose fill color = 
any do the same processes for rest of the others. 

 
Perspective text: 
Steps: 

1. Type INFORMATION 
2. Then create it outlines 
3. And from the tool box choose free transform tool and select and drag from 

the corner do not release the mouse cursor and during the dragging process 
hold on shift key and ctrl key when the view point is changed first released 
the mouse and then keys. 

 
Pattern Text 
Steps: 

1. Firstly type your text, e.g. Student Project Nepal 
2. Now, go to window menu choose swatches, whether it is activated or not 

you can identify by selection that tool 
3. After that select direct selection tool and click and drag the text to swatches 

box which allow you to make a new design patterns 
4. Now create a rectangular object 
5. And choose fill color and choose your own text pattern and check the effect 

 
Lighting mode: 
Steps: 

1. Select that whole pattern box 
2. Now go to window menu choose transparency and on the transparency box 

decrease the opacity to 50% and check the effect. 
 
Creating the object pattern 
Steps: 

1. Firstly create 2 different object with reverse position with different color 
2. Then choose alt key and selection  

 
Color box: 
The color box contains 2 different color effects 
 

1. Stroke color = line color 
2. Fill color= object fill color 

There is none color just below the color picker field if you don’t need color then 
you can choose that one 



                                   Student project Nepal  
                                          Thahity, Kathmandu, Nepal 
 Phone No: 014228467 

Krishna Kumar shrestha 
krishna_98a@hotmail.com 

10 

 
Creating Logos 
Steps: 
Adobe illustrator allow you to change the text shape and size as your requirement 
that means it is text editing software and easy to create logos 

1. Firstly Type “STUDENT” 
2. Then convert it to an object right clicking on create outlines 
3. Then with the help of Direct selection tool you can changes its shape 

according to your requirement by clicking on anchor point 
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SPNCI LOGO 
Steps: 

1. Create a circle object holding on shift key 
2. Then Press ctrl C and Ctrl F (copy and paste exactly over the previous 

object) 
3. After that choose pen tool and draw a line across the object 
4. Then go to object menu choose path and click divide object below 
5. Now you will have 2 divided objects 
6. Choose selection tool and select below object and choose fill color = any 

other 
7. Then press Ctrl C and Ctrl F and change its fill color  
8. Now select above object and choose fill color = any and press Ctrl C and 

Ctrl F 
9. Now choose path type tool and click over the above divided object and type 

“Student Project Nepal” and select it  
10. Now press Ctrl and T for text box  
11. On the text box choose the last option and set it to – 25 to bring the text 

inside the object and change the color to White 
12. Now Choose Path Type tool and click over the below object and type 

“Computer Institute” and  
13. Choose selection tool and click over the cursor shown outside the text 

boundaries to bring the text below portion  
14. Now Select that text and on the text properties box enter the numeric value 

to 15 and check the effect to bring the text inside the box  
15. After that Just type “ Estb. 2001” and manage the text between the divided 

portion of an object. With white color 
 
There are several reasons to create a duplicate copy of the circle object because if 
you didn’t create a duplicate copy of the object then you will not allow viewing 
the fill color of the object 
The reasons of entering – numeric value on the text properties box is to bring your 
text inside the box 
 
So on you can create your logos as the requirements 
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Clipping Mask: 
Steps: 
 

1. Open Illustrator 
2. Then go to file menu choose place and place any image  
3. Then on the tool box choose rounded rectangular object and draw over the 

image  
4. After that select both image and click at object menu choose clipping mask 

and click at make and check the effect 
5. And finally select the image and press Ctrl and G group 

 
Line Segment tool: 
Allow you to add line on art area 
Steps: 

1. Choose line segment tool and hold on shift key and drag on art area to draw 
a line 

2. Or Choose line segment tool and click once on art area and define require 
angle and length and click ok 

 
Arc Tool:  
Allow you to add arc object on art area 
Steps: 

1. Choose arc tool and click once on art area and on the box enter require 
value e.g. 

2. Length X axis = 2 in, length Y axis = 1 in, Type = opened, based along = X 
axis or Y axis and Slope = 90 and click ok 

3. Or 
4. Choose arc tool and hold on alt key and arrow up or down and check the 

effect 
 
Spiral tool:  
Allow you to add spiral object on art area 
Steps: 

1. Choose spiral tool and click once on art area and  
2. Define required value e.g. Radius =4 in, Decay = 80, segments = 900 and 

style = any and click ok 
3. Or 
4. Choose spiral tool and hold on alt key and arrow up and down and drag on 

art area when finished release the mouse and check the effect 
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Rectangular Grid tool: 
Allow you to add numbers of rows and columns table on art area 
Steps: 

1. Choose rectangular grid tool  
2. Then click once on art area and on the box fill require value and click ok 

and check the effect 
3. Or  
4. Choose Rectangular grid tool and click and drag while holding on alt and 

arrow up and down key and when finished release the mouse 
 
Polar Grid tool:  
Allow you to add circular rows and column on the art area 
Steps: 

1. Choose polar grid tool  
2. Click once on art area and on the property box enter require numbers and 

click ok  
3. Or  
4. Choose polar grid tool, click and drag while holding on alt and arrow up or 

down key and when finished release the mouse and check the effect 
 
Flare tool: 
Allow you to add flare (lighting effect) effect on art area 
Steps: 

1. Choose flare tool  
2. Click once on art area and fill the require value on given field  
3. Or 
4. Click and drag once then from the middle part of the flare object drag it to 

the required portion and check the effect 
 
Brush tool: 
Allow you to draw a free hand art. 
Steps: 

1. Choose brush tool and click and drag as you need on art area  
1. If you wish to continue the design from the previous art then click on the 

anchor point and continue your design. 
 
Pencil tool:  
Allow you to draw a free hand art using the pencil tool on art area 
Steps: 

2. Choose pencil tool and click and drag as you need on art area  
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3. If you wish to continue the design from the previous art then click on the 
anchor point and continue your design. 

 
Smooth tool: 
Allow you to change your selected objects shape by clicking and dragging from 
the anchor point 
Steps: 

1. Draw a rectangular object 
2. Choose smooth tool and double click on the tools and change the require 

settings and then click and drag from the anchor point to change its shape 
and check the effect 

 
Erase tool: 
Allow you to erase your free hand by clicking and dragging from the anchor point 
Steps: 

1. Draw a rectangular object 
2. Choose erase tool and click and drag from the anchor point from both side 

of the object and check the effect. 
 
 
Rectangle tool: 
This tool allows us to create a rectangular object on art area. 
There are two ways to create a rectangular 
Steps 

1. Select rectangular tool and click once on art area 
2. Then a box displays 
3. Enter required height and width 
4. And then click on 
5. Select rectangular tool 
6. Hold on shift key then draw a rectangular object on art area  
7. Do not release the shift key until the drawing process is completed 

 
Rounded Rectangular  
This tool allows us to create a rounded corner object on art area 
Steps: 

1. Select rounded rectangular tool and click once on art area  
2. Then a box displays  
3. Enter required height and width and for the round corner enter required 

radius 
4. And then click ok 
5. Select rounded rectangular tool 
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6. Hold on shift key until the drawing process is completed 
 
Circle tool  
Allows us to draw a circular or oval object on art area. 
Steps: 

1. Select circle tool and click once on art area 
2. Then a box displays 
3. Enter required Height and width 
4. And then click ok 
5. Select circle tool 
6. Hold on shift key then draw a circle object on art area 
Do not release the shift key until the drawing process is completed or if you 
need oval object then do not hold shift key 

Polygon tool: 
This tool allows us to draw a polygon object on art area 
Steps: 
1. Select polygon tool and click once on art area 
2. Then a box displays choose radius = numeric value and enter required sides  
3. And when finished click ok and check the effect 
4. Select polygon tool  
5. Hold on Alt and arrow up or down while dragging the mouse key 
6. When finished release your mouse and check the effect 

 
Star tool 
This tool allows us to draw a star object on current art area. 
Steps: 

1. Select star tool 
2. Then draw a star on art area 
3. During the dragging process hold on alt and arrow up or down 
4. Do not release the mouse until all the requirements are fulfilled 
5. Select star tool 
6. Click once on art area 
7. On the box entered radius 1 = 100 and radius 2 = 50 and points =32 
8. And click ok and check the effect 

 
Rotate tool: 
Through this tool you can rotate any object as your requirement 
Steps: 

1. Draw a line using brush tool 
2. Select rotate tool and hold on alt key and click on art area 
3. Then a box displays enter 25 degree on the angle box and click copy 
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4. Now press Ctrl and D for several times and check the rotate effect 
 
Reflect tool: 
Allows us to reflect the selected image 
Steps: 

1. Go to file menu choose place 
2. Then open any image from require location 
3. Now select reflect tool and hold on alt key and click once on art area and on 

the box just click copy and check the changes 
 
Twist tool: 
Twist or change the object shape 
Steps: 

1. Draw an object e.g. rectangular 
2. Choose twist tool and click and drag to rotate the object to the anti 

clockwise and check the effect. 
 
Scale tool: 
Allows us to change current object scale 
Steps: 

1. Draw an object e.g. rectangular 
2. Then choose scale tool and hold on alt key and click exactly at the central 

part of the image 
3. Now, choose uniform = 90 and click copy 
4. After that press Ctrl and D for several times and check the effect 

 
You can select the position of scale anywhere on the art area as your requirement 
Shear tool:  
Shear the object as our requirements  
Steps: 

1. Create a rectangular object 
2. Then, choose shear tool and hold on Alt key and click  
3. On the box enter require share angle e.g. 25 and click ok  
Then check the effect 
 

Reshape tool:  
Insert or ads an anchor point for reshaping an object 
Steps: 

1. Draw a rectangular object 
2. Then, choose reshape tool and click exactly on path 
3. Now with the help of direct selection tool you can change its shape 
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Wrap Tool 
Through this tool you can change the object shape as a wrap effect. 
Steps: 

1. Create a rectangular object 
2. Then select wrap tool area (the object must be selected) 
3. Click and drag from the reuqired point to change it’s shape 

 
Twirl Tool 
Twirl the object, as you like 
Steps: 

1. Select your object 
2. Select Twirl Tool and click on the path to twirl it as you need 
3. When finished release mouse 

 
Purker Tool 
Combines the different points in a same point 
Steps: 

1. Draw some objects at least two 
2. Select the objects and select purker tool and click at once on the similar 

point of both objects and checkt the changes 
 
Bloat Tool 
Change the object shape in a circle or oval shape 
Steps: 

1. Create a small rectangular object 
2. Select Bloat Tool and if you need to make it oval then hold on Alt key and 

click up/down, when finished click on the mid of the rectangular object and 
check the changes 

 
Scallop Tool 
This tool allows us to add the multiple points on selected objects 
Steps: 

1. Create a rectangular object 
2. Select Scallop Tool and click on the path and check the changes 

Note: you can change Scallop Tool size by holding on Alt key and clicking up and 
down 
 
Wrinkle Tool 
Through this tool we can add the wrinkle effect on the selected object or an image 
Steps: 
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1. Create an object 
2. Select Wrinkle Tool and click on the requried portion and check the effect 

Note: Hold on Alt Key and drag up and down to increase or decrease it’s size, for 
the image you must select the open from file menu not a place option 
 
Symbol Spray Tool 
Through this tool you can add the symbol as a spray effect to the required position 
Steps: 

1. Select Window menu choose Symbol 
2. Then from the Symbol Pattern choose the required symbol and drag it to 

the art area 
3. Then select Symbol Spray Tool and click on required portion to add and 

check the effect 
 
Symbol Seizor Tool 
Increases the symbol size 
Steps: 

1. Insert a Symbol 
2. The select Symbol Seizor Tool 
3. And click exactly on the selected symbol and check the changes 

 
Symbol Strainer Tool 
Inserts color or the symbol of the fill color or effect 
Steps: 

1. Insert a Symbol 
2. Change a fill color and click at Symbol Strainer Tool and click on symbol 

and check the effect 
 
Symbol Screener Tool 
Make the image as a screen effect 
Steps: 

1. Insert a symbol 
2. Then click at Symbol Screener Tool and click once on the symbol and 

check the effect 
 
Symbol Staler Tool 
Applies the symbol style 
Steps: 

1. Insert a Symbol 
2. Choose Style=Any 
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3. Then click at Symbol Staler Tool and click on the symbol and check the 
effect 

 
Stacked Column Diagram 
Through this tool you can add the column diagram for your data 
Steps: 

1. Select Stacked Column Diagram Tool then define the area for diagram on 
art area 

2. Then select the Apply button (√ sign) and choose ti’s panel and check the 
effect 

3. Do the same process for rest of the other chart type as your requirement 
 



                                   Student project Nepal  
                                          Thahity, Kathmandu, Nepal 
 Phone No: 014228467 

Krishna Kumar shrestha 
krishna_98a@hotmail.com 

20 

 
Gradient Mess Tool 
Inserts a gradient field for the selected object 
Steps: 

1. Create a rectangular object 
2. Select Gradient Mess Tool 
3. Then click on the rectangular where you need to add mesh 
4. Then select Direct Selection Tool and click exactly on the mid of the object 

(not on the line) 
5. Click Fill Color and fill it with required color from the clor picker box 

 
Gradient Tool 
Allows you to add gradient color on the selected object 
Steps: 

1. Create a rectangular object 
2. Select Gradient Tool and from the box choose requried Gradient box color 

and if you need to increase it’s color field then click once on the path and 
choose required color and check the effect 

So on if you need to remove the color then select the gradient object and from the 
gradient box click and drag the color pointer and drop down (to remove) and 
check the effect 
 
Eyedropper Tool 
Through this tool you can fin out the color of the slected object 
Steps: 

1. Select File menu, open any image 
2. Then sleect Eye Dropper Tool and click on the image and your color will 

occur at the fill color box 
 
 
Paint Bucket Tool 
Through this tool we can fill any color of the current object by clicking once on 
the reuiqred object 
Steps: 

1. Create a Rectangular Object 
2. Fill it with Red Color 
3. Create another rectangular object and fill it with blue 
4. Then slect the Paint Bucket Tool and slect the red object and click once on 

the blue object or the central part and check the changes 
 
Measure Tool 
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Allows us to measure height and width of the current object 
Steps: 

1. Draw a Rectangular Object 
2. Choose Measure Tool and click at the strating point of the top left to the top 

right to find out the length of the object it will show on the info button at 
the top of the windows 

3. Then click and drag from top left to down and check the width of the given 
object 

Note: This will be very effective to measure the required height and width of the 
given object 
 
Blend Tool 
Blending two objects as a pillar with reuiqred color 
Steps: 

1. Create two rectangular objects 
2. Then manage the position of the current object up and down a bit far away 

from each other 
3. Then select Blend Tool and exactly click at the central point of the selected 

object to blend it 
 
Auto Trace Tool 
Allows you to create a stature of the selected image 
Steps: 

1. Open an image 
2. Then select Trace Tool and choose the required fill color 
3. Then rub on the image until all the part are not completed 
4. The finally deselect the original image and check the effect 

 
Trace Tool 
Steps: 

1. Place Bitmap Image 
2. Then double click on Trace Tool 
3. Then a bar displays choose the following options 

Type 2 Auto Tracing 
Size reading 2pt Tracking 20/1000cm 
Baseline shift 1pt 
√ Type Area Select 
Auto Trace Tolerance 2pt 
Tracing Cap 0 pt 
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 If the trace box is not activated after the double click then choose Edit 
menu > Preferences and then select type and auto trading, then, Set the options by 
changing the numeric value and click at Ok. 

4. Choose required fill color before you Trace 
5. Then click on path line of Bitmap to trace it 

 
Slice Tool 
Through this tool we can preserve the hyperlink option on the selected object and 
also it divides the object according to the selection. 
Steps: 

1. Create any Object 
2. Select Slice Tool and click and drag on the object 
3. Then choose Object menu, choose Slice and click on Slice Option 
4. Then on the option box enter the Url=Link page 
5. Example: C:\Documents and settings\spn\destktop\your folder name\your 

page name 
6. Choose Target=any example: Main (Open a link page in the new Window), 

_selft (Open the link page in the same window) 
7. Choose Slice Type=image and click at Ok 
8. After this, save your object as a web page through File menu 
9. Then open the saved file then a hand object shown click once and check the 

effect 
 
Scissor Tool 
Release the object fills color and set only the outline color 
Steps: 

1. Create a rectangular object 
2. Fill it with any color 
3. Choose Scissor Toola nd click exactly on the anchor option or point 
4. Do the same process for the other anchor point and check the changes 

 
Knife Tool 
Divides the object as your requirement 
Steps: 

1. Draw a Rectangular Object 
2. Choose Knife Tool and click and rag from one corner to another end of 

corner 
3. Then choose Direct Selection Tool and click on the divide position and 

change it’s color or outline and check the changes 
 
Hand Tool 
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Allows us to view the object in any position of art area by simply dragging to 
reqruied position 
Steps: 

1. Draw any Object 
2. Choose Hand Tool and drag the object to reuqired position 
3. It does nto allow you to drag the object, it drags the whole art area 

 
 
Page Tool 
Inserts a logical page 
Steps: 

1. Select Page Tool and click on art area and check the logical page, it allows 
you to fix the document size when you need to print 

 
Zoom Tool 
Increase or decrease the current art size or works as a magnifier but the original 
layout is always 100% 
Steps: 

1. Choose Zoom Tool and click on Art Area and check the changes 
2. Hold on Alt Key and click to decrease the Zoom size 

 
Filter Menu 
Some of the option from filter menu doesn’t allow you to apply the effect on draw 
object. When these menus are D-Active then the menu options are for the bitmap 
images or images. So apply the effect on inserted images. 
Anod some of the options are not active while image is already in art area then that 
effects are only for the draw object 
 
Effect Menu 
Applies effect for object, images and text. So before applying this effect you must 
select the requried inserted object and choose any effect as your requirement. 
 
Transparency 
Applies spacing effect 
Steps: 

1. Insert any images 
2. Choose transparency via Window menu 
3. And decrease the capacity to 50% and check the Transparent effect 

Pathfinder tool: 
 
Through this tool we can edit with selected object for multipurpose, such as crop, 
combine, divide etc.To active the pathfinder tool Select window menu. Choose pathfinder 
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Add to shape area: 
Steps: 
 

1. Create at least 2 object like below 
 

 Before 
2. Now select selection tool and select both object and on the pathfinder tool 
3. Click add shape area and the result will be 

 

 After 
 
Subtract with sub area: 
Steps: 

1. Create at least 2 objects like below 
 

 Before 
2. Now select selection tool and select both objects 
3. Then choose subtract with sub area and the result will be  

 

 After 
Intersect shape area: 
Steps: 

1. Create at least 2 objects like below 
 

 Before 
2. Then select selection tool and select both objects 
3. After that choose intersect shape area and check the effect 

 
  After 

 
Exclude overlapping shape area: 
Steps: 

1. Draw 2 objects  
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 Before 
2. Then select both objects and choose Exclude and check the effect 

 

 After 
 
 
Divide: 
Steps: 

1. Draw at least 2 objects 
 

 Before 
2. Select both and choose divide 
3. Choose direct selection tool and click once on outside the object 
4. Now, separate each other from joint 

 

 After 
 
And check the effect 
 
Trim: 
 
Steps: 

1. Draw 2 objects 
 

 Before 
2. Select both objects and choose Trim 
3. And check the result 

 

 After 
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Merge: 
Steps: 
 

1. Draw at least 2 objects 
 

 Before 
2. Select both object and Merge 
3. Now, with the help of direct selection tool, separate each other and check the 

result 
 

 After 
 
Crop: 
Steps: 
 

1. Draw 2 different objects 
 

 Before 
2. Now select both object and crop it 
3. Then check the result 

 
After 
 
Minus Front: 
 
Steps; 
 

1. Draw 2 objects 
 

 Before 
2. Select both and choose Minus Front and check the effect 

 
 After 
 
Outline: 
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Steps: 
 

1. Create 2 objects 
 

 Before 
2. Select both objects and choose outline and check the effect 

 
 After 
 
 
 
 

 Adobe Photoshop 7.0 
Photoshop, now up to version 7.0, is the leading professional image-editing program, 
released by Adobe. Photoshop is useful for both creating and editing images to be used in 
print or online. Easy to use, but full of high-quality features, Photoshop is the best choice 
for any image manipulation job. 

How to open Photoshop? 

1. Click on start menu. 

Steps: 

2. Select on all program. 
3. Choice Photoshop. 

  Or   

4. Click on start button. 
5. Click on run. 
6. Type in "run" then press on ok button. 
7.  
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then we can see Photoshop windows display in your computer. 

 

File - create new images, open pre-existing images, print, exit the program, etc. 
Edit - undo, copy, paste, cut, preferences, basic image manipulation, etc. 
Image - change the image or canvas size, rotate, adjust brightness & contrast, etc. 
Layer - Create / delete layers, merge layers together, layer effects, etc. 
Select - Adjust the selected area of your image 
Filter - Apply filters and effects to your images 
View - Zoom in and out of your images 
Window - Open or close different windows within Photoshop 

Creating a New Canvas / Image: 

1. Go to the "File" menu. 

 
steps: 

2.  select "New" (or press Carlen). 

 

3. you can give your requiredment. 
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Opening a Pre-existing Image:

1. Go to the "File" menu and select "Open" (or press Ctrl+O). 

 
stpes 

 

Find the image on your computer that you wish to edit, and click "Open." Your image 
will open in a new window within Photoshop. 

 

Editing an Image: 
Once you have an image created or opened, you can edit or draw on top of it with 
Photoshop's "Tools" window, which is the long, thin window that is automatically 
open on the left side. Here is a breakdown of all the tools contained on this bar: 

About in Layers:  
One of Photoshop's most powerful features is the ability to create and use multiple 
layers within the same image. A layer is literally what it sounds like: one layer on top 
of another, all of which can be edited independently of each other and laid on top of 
or beneath one another, and then later combined to form a single, flat image. When 
you first create an image, you will be working with the "Background" layer. You 
cannot always use all effects on a background layer, so you may wish to start 
working directly with normal layers. To create a new layer, click the "Layer" menu, 
and pick "Layer" from the "New" menu (or click Shift+Ctrl+N). 
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In the new window that pops up, click "OK." 

Now look down in the bottom-right of the screen to the lower-most window, which 
we haven't looked at yet. It will have three tabs on it: Layers, Channels, and Paths. 
We'll be staying on the main "Layers" tab, for now. It should look something like 
this: 

 

You will notice that "Layer 1" is above "Background" in the window. This means that 
anything that's on Layer 1 will take priority over anything in the Background layer. 
Things in the Background layer will be obscured by things in Layer 1. Why would you 
want to do this? You can switch back and forth between layers to move items 
independently of items in other layers, allowing you to lay things out exactly as you 
want. 

So what are all these options in the layers window? 
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1. Paintbrush Symbol - This symbol (and the blue shading of the layer) notes the 
currently active layer 

2. Show / Hide Layer - When the eye icon is visible, the layer is displayed in your 
project. If the eye is clicked, then the layer is hidden but not deleted. 

3. Link Icon - Indicates if the layer is currently linked to another layer. When 
linked, layers act "locked" together (and will move with each other, accordingly), but 
still remain separate layers. Layers can be linked together by selecting one layer, 
and then clicking the boxes in the other layers to display the "Link" icon (number 
three on the above list and image). 

4. Background - The Background is technically not a layer, however, it can be 
edited. It is the bottom-most portion of the image. 

5. Layer - Each layer has its own name (default is by numbering). Click a layer's 
name to edit on that layer. 

6. Text Layer - Adding text creates a new text-specific layer. 

7. Effects - When you add effects to a layer, a sub-menu appears with that layer 
listing the effect applied to it. Double-click an effect's name to bring up that effect's 
menu to make adjustments. 

8. Add a Layer Style - By picking an option from this menu (such as Drop Shadow, 
Inner Glow, or Bevel and Emboss), you can apply special effects to a layer. 

9. Add a Mask - Masks are used to hide pixels on a layer in order to view the rest of 
the image. Layer masks are either a black or white background color. The default 
color is white, which lets pixels be seen, while black hides pixels. 
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10. Create a New Set - By making a new set, you can create a separate folder for 
layer storage. 

11. Create New Fill or Adjustment Layer - The options in this menu allow you to 
change the color properties and dimensions of a layer. For example, you can make a 
layer lighter or darker, add a gradient (a blending of two colors), or invert the entire 
layer. 

12. Create a New Layer - Clicking on this icon creates a new layer. You can name 
your layer in the text box that appears and position it in the palette. 

13. Delete a Layer - Deletes the currently selected layer. You can also drag a layer 
to the trash. 

14. Opacity - Use this to adjust a layer's opacity (its transparency). 

Some notes about layers: 

• Layers can be repositioned in different orders in the Layers palette by clicking 
on a layer and dragging it to a new position in the palette. To make a layer 
appear on the top-most part of the image, drag it higher up on the list. Do 
the opposite to position a layer at the bottom-most area of an image.  

• Only a selected layer can be edited. To select a layer, click on the layer name 
in the palette.  

• You can only work with layers in a *.psd file (Photoshop's native format). If 
you want to modify a *.gif or *.jpg file (or any other type of image file) with 
layers, copy and paste that image into a new, blank Photoshop canvas. 

 

Switching Back and Forth between Layers:  
The layer that's selected under the "Layers" tab will be the one changes are made to 
when working on the canvas. If you wish to work on a different layer, click the name 
of that layer. Remember, if you want to bring a different layer to the front of the 
image, click and drag it above or below to where you want it. 
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Cropping an Image: 
If an image is too large and you would like to cut it to just focus on 
one section of the image, you can "crop" it to that size and area. 
Select the "Crop" tool, and click and drag around the area you want. 

 You can resize the area (or rotate it) with 
the mouse by clicking any of the corners. When you're done, just click over to any 
other tool and a window will appear asking you if you'd like to crop the image. Click 
yes, and the image will be reduced to the area you've specified. 

Resizing an Image: 

If you don't want to crop your image (meaning you want the ENTIRE image, just at a 
smaller size), you can resize your image to any dimensions you wish. Select "Image 
Size" from the "Image" menu. 

 

The default in Photoshop is to keep image resizing at "Constrain Proportions." This 
means that if the height is changed, the width will be changed at the same ratio. 
This keeps your image looking approximately the same, only at different sizes. If you 
wish to change this, just un-click the "Constrain Proportions" check box at the 
bottom of the "Image Size" window. 
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You can change the image size either by pixels or percentages. Use either you wish 
to either enlarge or reduce the size of your image (keep in mind that enlarging 
images will reduce the quality). 

Moving an Image:  
You can move an image to any area of the canvas you wish. Select the "Move" tool, 
and click and drag the image to any area of the canvas you wish. 

 

Selecting / Deleting a Part of an Image: 

Choose the "Marquee" tool, and click and drag around a part of an image. A rotating, 
dotted line will surround that area. To delete this section that you've selected, hit the 
"Delete" key on your keyboard. 

 

The "Magic Wand" can select a larger area of an image by grabbing similar looking 
pixels and grouping them together. Select the Magic Wand tool and click an area of 
an image. It will select a large portion of the area which you can move, delete, etc. 
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Adding Text:  
Click the "Text" tool on the tool bar and click in your image where you'd like to add 
text. 

 

The text will appear on top of the image, and it will be on its own new layer. You can 
change the font, style, size, anti-aliasing, and color of your text on the menu directly 
below the main Photoshop menu. 

 

Altering Your Images: 
Photoshop's most powerful aspect is its ability to edit and manipulate images easily 
and with professional quality. The second section of the tool menu contains tools that 
specifically help you to edit your images. When you click any of these tools, 
Photoshop's sub-main menu will change to reflect new options available to you. Most 
will look something like this, or very similar: 

 

1. Name - The name of the tool you're using. 

2. Brush Picker - Here you can select the diameter, hardness, and spacing of the 
brush / tool you are using. 
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3. Mode - Effect mode 

4. Opacity - The transparency of the tool's effects. 

5. Flow - The flow rate of the stroke. 

6. Airbrush - Click to enable airbrush capabilities with the tool. 

Brush / Pencil Tool 

The Brush tool can be right-clicked to also show the Pencil tool as an option. Both 
are very simple tools that allow you to directly draw on top of an image. Select a 
color with the Foreground Color option on the tool bar, and select a brush size from 
the tool's sub-main menu, above. Click and drag across an image to draw on top of 
it. 

 

Clone Tool 

 The Clone tool will copy pixels from one part of an image and copy them to a new 
part of the image. The Clone tool is most useful in situations such as removing 
blemishes from a face in a photograph, clearing a few clouds out of a bright blue sky, 
etc. Choose the Clone tool. Hold the "Alt" button on your keyboard, and click in an 
area of the image that you'd like to copy. Now click elsewhere in the image, and 
move the cursor around. The image will "clone" itself to that second area. 
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Eraser Tool 

The eraser simply deletes sections of an image. Click the Eraser tool, and click and 
drag around your image. The eraser will "erase" the image to what's set as the 
Background color. 

 

Gradient / Paint Bucket Tool 

The Gradient tool can be used on its own, or right-clicked to also select the Paint 
Bucket tool. 

 

A gradient is a horizontal fading of colors, most commonly used in the creation of 
banners for web pages. Select the Gradient tool, and go to the sub-main menu for a 
drop-down of available gradients. The default is the most common. 

 

Once you've selected which gradient you wish (and a color in the Foreground color 
tool), just click and drag across your image. The direction you drag (left to right, 
right to left, etc.) determines the flow of the gradient. 
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The Paint Bucket lets you fill in a large section with the same color. Select the Paint 
Bucket by right-clicking the Gradient tool, and click in an area of your image. It will 
fill with the color selected as the Foreground color. 

 

Blur Tool 

The Blur tool is useful for covering up small distortions in an image by blending the 
surrounding pixels together. To blur something, select the Blur tool, and click and 
drag around the area you wish to blur. 

 

Rotating an Image: 
You can rotate and flip your image in any direction you wish. In the "Rotate Canvas" 
list under the "Image" menu, there's a wide variety of options to choose from. 
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If you select "Arbitrary" for a rotation, a new window will appear asking you for the 
direction (clockwise or counter-clockwise) and the degree of the rotation. 

 

Drawing Shapes: 
While Photoshop's main power is in manipulation of images, it's also possible to draw 
your own (as seen with the pencil and pen tools). The Rectangle tool (and all of its 
sub-tools) allows you to draw shapes on a canvas. To draw a simple rectangle, pick a 
Foreground color (which will be the fill color for the shape), select the Rectangle tool, 
and click and drag on the canvas until it's the size you wish. 

 

Note that drawing a shape will create a new layer. 

You can draw a wide variety of shapes with the Rectangle tool and its sub-tools, 
including the Custom Shape Tool, which gives you even more options. Select the 
Custom Shapes Tool (by right-clicking the Rectangle tool), and look through your 
options in the drop-down box from the sub-main menu. 
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Your choices include word bubbles, arrows, and even shapes that don't fill 
themselves in with a color. 

Eyedropper Tool: 
When working with images, you may find that you want to reselect a color you've 
used, but aren't sure exactly what color it is. You can use the Eyedropper tool to 
reselect that exact color for you. Select the Eyedropper tool, and click anywhere on 
an image that has the color you want to select. 

 

The Foreground color will change itself to the color you've selected. 

Zoom Tool: 
If you find that you need to zoom in or out of your image for any reason (for 
example, to be more precise in deleting areas), you can use the Zoom tool. Click the 
Zoom tool (it looks like a magnifying glass). If you click once on your image, it will 
zoom to double its size (100% to 200%, and so on). 

 If you right-click, you can select the "Zoom 
Out," which will reduce its size. Note that this doesn't actually change the size of the 
image. It simply changes your view of the image on the canvas. 
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Thank You 
        Coming soon............................  

Computer hardware & Networking 
book 


	A d o b e   I l l u s t r a t o r   1 0
	How do I open Adobe illustrator?
	Working with art area

	Black Arrowhead (Selection tool)
	White Arrowhead (Direct selection tool)
	Magic Wand tool:
	This tool allows you to active the current deselect object
	Pen tool:
	This tool allows you to draw a straight line and, curve line
	Subtract Anchor Point
	Type tool
	Area Type tool:
	Allow you to type the text with in a given area
	Path Type tool:
	Allow you to type the text with in a given path.
	Vertical type tool:
	Allow you to type vertical text in the art area
	Vertical path type tool:
	Allow you to type vertical path text within a given path
	Pattern Text
	SPNCI LOGO
	Rounded Rectangular
	Circle tool
	Star tool




